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Foreword

The Hydrologic Engineering Center's utility program for managing gridded data with
HEC-DSS (Hydrologic Engineering Center's Data Storage System), provides an interface
that facilitates viewing of gridded data and performs basic utility functions on gridded
data that then is stored as time-series in HEC-DSS. The structure of gridded data (raster
data) isthe result of converting scattered individual data pointsinto agrid of calculated
hypothetical values.
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Chapter 1

Introduction

1.1

1.2

Purpose

In support of the Corps Water Management System (CWMS) modernization project, a
program was devel oped to facilitate basic viewing, processing, and analysis of gridded
data setsin HEC-DSS (Hydrologic Engineering Center's Data Storage System). This
program is the Hydrologic Engineering Center's Grid Utility program, HEC-GridUtil.
Sequences of grids typically approximate the variation through space of a quantity
measured varying through fixed-intervals of time at fixed locations. The predominant
types of gridded datain DSS are regular-interval time series of hydrologic variables
distributed over afixed geographic extent, such as Stage 3 NEXRAD (Next Generation
Radar) precipitation, or mean daily temperatures throughout a basin. Storage in HEC-
DSS primarily facilitates use of the data by the HEC-HM S (Hydrologic Engineering
Center's Hydrologic Modeling System) model and the CWMS CAV1 (Control
Acquisition Visualization Interface), but also provides advantages regarding access
speed, data organization, file size, portability, multi-platform support, and avoidance of
requirements for licensing proprietary software.

DSS Concepts

Time series of spatial information have become increasingly important to mainstream
hydrological applications, but they pose challenges regarding standardized storage and
indexing. The structure of gridded datain HEC-DSS provides very efficient storage of
and access to data sets of the same parameter, expressed in the same units, covering the
same grid cells (in terms of spatial extent and coordinate definition) throughout a
recurring constant time interval.

Each HEC-DSSfileis a stand-alone database file, and can be easily shared among users
and applications that recognize HEC-DSS, without platform conversions or external
dependencies such as schema definitions. HEC-DSS is primarily designed to facilitate
use of times-series data such as hourly water levels, or monthly mean discharge. The
primary tool for managing HEC-DSS data is the HEC-DSSV ue software (Hydrologic
Engineering Center's Data Storage System Visual Utility Engine)
(http://www.hec.usace.army.mil). HEC-GridUtil performs utility operations specific to
gridded datain HEC-DSS, although many ordinary management tasks, such as copying
data between HEC-DSS files or renaming records, are performed using the HEC-
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1.3

DSSV ue software. HEC-DSS stores gridded data according to descriptive record
identifiers (i.e., pathnames), consisting of six brief descriptors:

e TheA-part refersto the grid's coordinate system. The two primary spatia
reference definitions are known as Hydrologic Rainfall Analysis Project
(HRAP) and Standard Hydrologic Grid (SHG). Appendices D and E provide
detailed descriptions of the HRAP and SHG coordinate systems. Some
functions of GridUtil only support gridded data stored in HRAP or SHG.

e By convention, the B-part describes the area covered by the gridded data,
such as awatershed or the region served by a National Weather Service
(NWS) River Forecast Center (RFC).

e The C-part refersto the parameter represented by the grid, such as PRECIP
or TEMP.

e The D-part contains the starting time of the period represented by the gridded
datain the pathname, such as 01JUL 2000:0500.

e The E-part contains the ending time of the period represented by the gridded
data in the pathname, such as 01JUL 2000:0600.

e The F-part contains user-specified identifying information distinguishing one
set of grids from another. Typical conventions include information about the
data source and/or some labeling indicating versioning or processing
operations. For example, data obtained from the North Central River Forecast
Center and then revised could have the F-part set to “NCRFC_REVISED.”

HEC-DSS assumes that the D-part and E-part of pathnames for gridded datareflect UTC
(Universal Coordinated Time). Neither HEC-DSS nor GridUtil performs conversions
between time zones.

In addition to the descriptors contained in the pathname, HEC-DSS records also include
header information. The header identifies the units, datatype, spatial definitions, and
statistics regarding the data values among the cells. Appendix A contains detailed
information regarding the format of gridded data stored in HEC-DSS.

Characteristics and Capabilities of GridUtil

HEC-GridUtil is available to the public at no cost, and without any forms of licensing or
registration. The software originated as an integral part of the Corps Water Management
System (CWMYS), and maintains a close linkage and shared code base with HEC-ResSim
(Hydrologic Engineering Center's Reservoir System Simulation), HEC-DSSV ue, and
other HEC models and tools.

GridUtil iswritten in Java, but also relies on libraries written in FORTRAN and C, which
currently limit supported platforms to Microsoft Windows and Sun Solaris. HEC can
accommodate other environments, such as Linux or MacOS, if funding is available and
the need aligns with HEC's support mission to USACE and partners.
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The primary objective of GridUtil isto provide convenient viewing and processing of
gridded data. Features of the current version of GridUtil include:

e Visualizing and animating sequences of gridded data
e Importing gridded data from external files
e Exporting datato GIS (Geographic Information System) and graphics files

e  Computing simple statistics, such as cumulative, mean, or maximum cell
values, across grid sets over a specified time period,

e Performing basic mathematical operations, such as adding cell values across
grids or multiplying a grid by a constant

e Creating amosaic by joining overlapping or adjacent grids
e Creating agrid set by extracting aregion of cells from an existing grid set
e Transforming HRAP grids to the SHG coordinate system

e Importing or exporting gridded data. This version of GridUtil includes
support for importing datain Arcinfo ASCII format. Other common formats
include XMRG (abinary file format used within the NWS to store gridded
data), GRIB (Gridded Binary), HDP (hourly digital precipitation), and
NetCDF (Network Common Data Format). XMRG and NetCDF files may be
imported using the utilities provided in the “grid” folder.

e Performing operations on grids from shell scripts

GridUtil represents gridded datain two forms: single grids and grid sets. A singlegrid
contains data for onetime interval, while grid sets represent a time sequence of a certain
gridded parameter sharing the same spatial definition. The map panel can superimpose
the gridded data on numerous reference layer types and formats, such as shapefiles or
geo-referenced JPEG (Joint Photographic Experts Group, *.jpg, *.jpeg) images.

Like HEC-DSSV ue, GridUtil relies heavily on the concept of a“time window” for data
operations. The period may be specified as an absolute reference (e.g., from 02Jun2007
0000 to 19Jun2007 2400), or in terms relative to the current time (the last seven days).
With certain exceptions, GridUtil operates only on the data records contained within the
time window.

GridUtil only performs coordinate transformations on data expressed in the HRAP or
SHG systems. Gridded data with undefined or custom coordinate systems are rendered
according to the cell size, number of rows and columns, and cell indices for the grid's
origin. When using gridded data outside the standard spatial reference systems, you must
assume full responsibility for matching the data and map coordinates.

GridUtil is designed for use by water resource engineering professionas and istailored to
tasks that occur in typical hydrologic analyses related to planning and operation of water
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management projects. GridUtil is not a geospatial processing program; coordinate
transforms, grid arithmetic, and spatial visualization are limited to specialized
implementations relevant to hydrologic engineering applications. GridUtil isalso not a
dedicated research tool, although it can be used in conjunction with other tools for
hydrological modeling and research applications. Computations implemented in GridUtil
are very well established and as simplified as possible, implemented using a
comprehensive GUI designed and tested to commercial standards.

1.4 Gridded Data Formats and Conversions

GridUtil relies on three external programsto read gridded data stored in XMRG,
NetCDF, or Arclnfo ASCII (text) format. GridUtil uses these programs to store the data
as DSS records and then loads these records. A fourth program can be used to convert
DSS records to Arcinfo ASCII format. These programs are listed in Table 1-1.

Table 1-1 External Gridded Data Utilities

Utility Program Pur pose

asc2dssGrid Converts gridded data stored in ESRI's Arcinfo ASCI| (text)
format to DSS
dss2ascGrid Converts DSS grids to Arcinfo ASCII gridded data format

gridLoadNetCDF  Converts data stored in NetCDF

gridLoadXMRG Converts National Wesather Service River Forecast Center (NWS
RFC) gridded data stored in XMRG format to DSS

These programs can be run manually from the Windows or UNIX command prompt or
used in a batch script to conveniently process multiple files. As ageneral rule, each file
contains asingle grid, which resultsin asingle DSS record.

The documentation available regarding these programs is provided in Appendix H and
Appendix I.

1.5 Documentation Conventions

The following conventions are used throughout this manual to describe the GridUtil
interface and operations:

e Most labeled GUI components (window titles, menu names, menu items,
button names, etc.) are shown in bold

e Folder (directory) names are shown in bold italics
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Chapter 2

Requirements and Setup

2.1 Hardware and Software Requirements

Before you install the HEC-GridUtil software, make sure that your computer has at |east
the minimum required hardware and software. In order to get the maximum performance
from HEC-GridUtil, recommended hardware and software is shown in parentheses. This
version of HEC-GridUtil will run on a computer that has the following:

Intel Based PC or compatible machine with Pentium processor or higher (a
Pentium 4 or higher is recommended).

A hard disk with at least 200 megabytes of free space
A CD-Rom drive (or CD-R, CD-RW, DVD), if installing from a CD.

A minimum of 512 megabytes of RAM (1 Gigabyte or moreis
recommended).

A mouse.

Color Video Display (Recommend at least a 17" monitor, running
1280x1024 or higher resolution).

Microsoft Windows XP, Vista, or Windows 7.

2.2 Installation Procedure

Installation of the HEC-GridUtil software is accomplished through the use of the Setup

program.

Toinstall the software onto your hard disk do the following:

1. Insert the HEC-GridUtil CD into your CD drive, or download the software from
our web site: www.hec.usace.army.mil.

2. The setup program should run automatically if installing from a CD. When
downloading from the web page you will need to save the setup filein a
temporary directory and then execute the “HEC-GridUtil_20_Setup.exe” fileto
run the setup program.

3. If the setup program does not automatically run from the CD, use Windows
Explorer to start the “HEC-GridUtil_20_Setup.exe” program on the CD.
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4. Follow the setup instructions on the screen.

The setup program automatically creates a program group called HEC. This program
group will be listed under the Programs menu, which is under the Start menu. The HEC-
GridUtil program icon will be contained within the HEC program group, within the HEC-
GridUtil subdirectory. The user can request that a shortcut icon for HEC-GridUtil be
created on the desktop. If installed in the default directory, the HEC-GridUtil executable
can be found in the “ C:\Program Files\HEC\HEC-GridUtil\2.0” directory (for computers
running 32-bit Windows) or the “ C\Program Files (x86)\HEC\HEC-GridUtil\2.0\"
directory (for computers running 64-bit Windows) with the name “HEC-GridUtil.exe.”

The HEC-GridUtil User’s Manua and example data sets are also installed with the
software. The User’s Manual can be viewed by selecting User’s Manual from the Help
menu. Y ou must have Adobe Acrobat Reader to view the user’s manual. This viewer can
be obtsained for free from the Adobe web page.

A zip file containing the example data sets used in this manual have been installed in the
“...\examples® folder within the program directory. Y ou can install the example data sets
by selecting the Install Example Data option from the Help menu. After selecting the
Install Example Data menu option, awindow will open for you to choose alocation to
install the example data sets. The program will create a subdirectory within your chosen
folder called “HEC-GridUtil Example Watersheds.” This folder will contain afolder
named “LCRA,” which contains a project file called “LCRA.wksp.”

Thefirst time a particular user account launches GridUtil, the program displays the
Terms and Conditions for Use dialog box (Figure 2-1). Please read the entire agreement
carefully. Oncethe final line of text appears, the button indicating your agreement
activates. Click OK, and the application continues.

B x|

Please read the follawing TCU carefully

ATOTTIEYS " Tecs, THaue Uy &ty Ul party ole 10 of arisiig out or your
use of HEC-GridUtl or breach of this Agresment or your violation of
arry law or the rights of a third party.

Py

Assent

Choosing the "I agree" option and selecting the "OK" button indicates

that you voluntarily accept these terms and conditions. If you do not
agree to these terms and conditions, please return any program

materials to HEC {If you downloaded the program and do not have

disk media, please delete all copies, and cease using the program). -

| agree to the abave Terms and Caonditions far Use

)1 DO NOT agree with the above Terms and Conditions for Use
[ox [ oo ]

Figure2-1 Termsand Conditionsfor Use Dialog Box
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2.3 Uninstall Procedure

The HEC-GridUtil Setup program automatically registers the software with the Windows
operating system. To uninstall the software, do the following:

From the Start menu select Control Panel.
Select Add/Remove Programs from within the Control Panel folder.

From the list of installed software, select the HEC-GridUtil program and
press the Remove button.

Follow the uninstall directions on the screen and the software will be
removed from your hard disk.
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Chapter 3

Using HEC-GridUtil: An Overview

3.1
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HEC-GridUtil Main Window

To begin working, ssmply double-click the HEC-GridUtil icon. The GridUtil main
window will open (Figure 3-1). This window shows the main components of the GridUtil
user interface. By default, the window opens to the last module you accessed. If thisis
the first time you are opening the GridUtil, GridUtil will initially open to the first module
you have access to.
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Figure3-1 HEC-GridUtil Main Window

The Map Panel displays the gridded data and optional reference layers. Whenever the
pointer enters the Map Panel, the lower |eft corner of the interface displays the
coordinates of the pointer. The Menu Bar, described in detail in subsequent paragraphs,
contains selections for accessing the main program functions. The Icon Bar provides
tools suited to different modes of the various functions. The Grid Configuration Panel
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becomes active when a gridded data set isloaded. This panel describes the data set’s
defining characteristics. The Message Bar displays information from GridUtil runs, such
as certain file accesses or accuracy of coordinate system transformations. The Status Bar
displays the coordinates of the last location of the cursor in the Map Panel.

The Time Series Panel displays time series of the mean, minimum, or maximum
averages of a Grid Set. The controls at the bottom of this panel allow playing, pausing,
stopping, and skipping through the gridded data. The black vertical line on the time series
plot and the date and time immediately below this plot indicate the time for which
gridded data will be displayed in the map panel. The starting and ending times of the
selected time window are shown above the horizontal slider bar. The slider control can be
dragged to quickly scan through the gridded data set. This control is disabled during
playback, after the Play [ button is clicked. Click the Stop (=] button before dragging the
slider bar. Note that when alarge Grid Set isloaded, along delay may occur before the
time series of the Grid Set is plotted.

Menu Bar

The menus in HEC-GridUtil alow you to load, save, view, edit, delete, and perform
mathematical and other operations on gridded data sets. The menu bar is shown in Figure
3-2.

|Eile View Single Grid Grid Set Data Analysis Data Management Tools Help |

Figure 3-2 Menu Bar

The File menu allows users to create a new watershed, save changes to a watershed, or
open an existing watershed. The bottom of the file menu provides a most-recently used
list of projects for quick access to frequently used watersheds. The File menu also
provides an option, called Save Map As, for storing a screen snapshot of the Map Panel
asanimagefile on disk. A list of File menu items, describing their actions, is provided in
Table 3-1.

The View menu alows you to modify several aspects of the display of gridded data or
reference layers. A list of View menu items, describing their actions, is provided in Table
3-2.

The Single Grid menu contains several options for creating, opening, closing, importing,
exporting, editing, saving, and deleting Single Grid data. A list of Single Grid menu
items, describing their actions, is provided in Table 3-3. These operations are described in
detail in Chapter 6.

The Grid Set menu contains several options for creating, opening, saving, closing,
editing, and deleting Single Grid data. A